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 1 Software Guide

 1.1 Overview

The Software Guide is an all-in-one document detailing how to use Spectrum Digital emulators and 
development boards with TI Code Composer Studio (CCStudio). The software guide provides steps on how to 
use the various tools required for debugging.

The sections listed in the table of contents only relate to the software tools used for building projects. The guide 
goes into very little detail about what problems may arise. For more information on debugging any possible 
problems, read the Troubleshooting guide located on the Spectrum Digital support website.

 1.2 Guide Resources & Reference

More in-depth and detailed information can always be found at:

Spectrum Digital Support Website ( http://support.spectrumdigital.com/ )

TI DSP Developers' Village Website ( http://dspvillage.ti.com/ )
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 2 JTAG

 2.1 Overview

JTAG ( Joint Test Action Group, IEEE 1149.1 ) is a common testing interface, used across multiple 
architectures, including TI's DSP line. The JTAG interface is standard across each of Spectrum Digital 
development board, allowing you to easy setup and communications. The standard interface also allows easy 
reuse of the same JTAG emulator hardware across multiple DSP platforms and processors.

 2.2 JTAG Interface

The JTAG interface is a set of pins from the DSP processor that allows you to connect to the DSP. A 14-pin 
JTAG connector is included on all Spectrum Digital development boards, as an extension of the DSP's JTAG 
interface. The JTAG connector is identical from each Spectrum Digital development board. The JTAG 
connector consists of a 14-pin layout with pin 6 removed as a keying mechanism. Having this common 
interface allows portability when programming and debugging of projects.

 2.3 JTAG emulators

The JTAG emulator is the bridge between the DSP and the PC. The JTAG emulator does all the work of talking 
to the DSP, and grants the PC direct access to the DSP's registers and on-chip peripherals. The JTAG 
emulator connects through the JTAG connector on each board, and comes in a variety of different ways to 
connect to the PC.

The USB and Parallel Port are the most common interfaces used.

 2.4 JTAG Scan Chain

The JTAG scan chain is an essential part of the JTAG interface, as it describes how individual components and 
are connected to each other. In the context of the DSP realm, the JTAG scan chain represents the logical 
layout of individual DSP processors, each having a length 'X'. SDConfig provides a way to view the length of 
the scan chain by doing the following:

1. Connector your Spectrum Digital JTAG emulator to the JTAG connector.

2. Power both the emulator and the board.

3. Launch SDConfig.

4. Click on the I/O port address number that corresponds to your emulator.

5. Run the Emulation Test ( Emulator -> Test ).

6. Read out the scan chain length and output.
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Here is the JTAG scan chain info for some TI DSPs:

DSP Processor Scan Chain Length
TMS320C24xx 8
TMS320C28xx 8
TMS320C54x 8
TMS320C55x 38
TMS320C64xx 38
TMS320C671x 46
TMS470R1x 4
TMS470R2x 4
BYPASS any

Here is an example of how the JTAG scan chain is structured:

Board Scan Chain
EVMDM642 TMS320C64xx (38)
EVM5509 TMS320C5500 (38)
OSK5912
 
 

BYPASS (8)
TMS470R2x (4)
TMS320C5500 (38)
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 3 PC I/O Ports

 3.1 Overview

Every JTAG emulator you will use has a unique I/O port address. The I/O port address serves to distinguish the 
different connection types, while making it easier to switch between emulators by only changing the I/O port 
address. Typical I/O port addresses are 0x378 and 0x278 for parallel port emulators, 0x240 for PCI emulators, 
0x510 for USB emulators, and 0x540 for embedded (on-board) USB JTAG emulators.

 3.2 SDConfig

A small utility called SDConfig is installed along with all Spectrum Digital emulator drivers. You can use 
SDConfig to configure your emulator with advanced options. Another important use for SDConfig is testing if an 
emulator connection is configured. To verify the emulator connection:

1. Launch SDConfig

2. Click on the I/O port address number that corresponds to your emulator.

3. Verify emulator connection ( Configuration -> Verify ).

4. Read the output pane, if the emulator connection can be verified, a message will display your 
connection status, if not the emulator connection will respond with an error.
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 3.3 PC Parallel Port

The parallel port present special problems because there may be several parallel ports on a given PC. Even 
when a PC has only one parallel port, it may not be clear what its I/O port address is. Furthermore, parallel 
ports have different operational modes that affect the JTAG emulator's performance and your PC's BIOS 
settings may have to be changed to obtain maximum performance. It is also a wise idea to have an 
unobstructed connection between the emulator and the PC parallel port connector, i.e. no switch boxes, no 
laptop docking stations, and no cable extenders.

First, checking your PC's parallel port address saves time and hassle, before you perform any modifications. 
The typical parallel port addresses are 0x378, 0x278, and 0x3BC. To figure out your PC's parallel port address.

1. Launch SDConfig.

2. Check for the available ports ( go to Configuration -> Ports Available -> Printer, USB ).

3. Read the output pane for the Port Address, Port Mode, and Port Speed.

Spectrum Digital recommends that the parallel port address be at 0x378 and in either EPP/ECP mode. 
Compare what your PC's parallel port settings are to what we recommend you to use. If your settings differ, 
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from 0x378 and ECP/EPP mode, you can change your PC's BIOS settings to match, or you can leave your 
existing settings. If you don't want to change your settings, you must remember the differences when you 
configure CCStudio in the later sections.

 3.4 PC BIOS Configuration

Changing your PC's BIOS requires that you restart your computer to make the appropriate changes. PC BIOS 
is the fundamental input/output control for your PC, by modifying the PC BIOS, you can obtain maximum 
performance when using the Spectrum Digital Parallel Port JTAG emulator. Follow these steps to change the 
BIOS, note it will be handy to write these instructions down:

1. Turn OFF your computer.

2. Turn ON your computer.

3. Press the key (or combination of keys) that you are prompted to enter when the PC starts up. This will 
starts the BIOS setup utility

4. The BIOS setup utility vary widely from computer to computer, but the options to change the parallel 
port are there. Navigate through the BIOS until you find the parallel port device settings.

5. When you have found the settings, change the port address to 0x378, 0x278, or 0x3BC ( 0x378 is 
recommend ) and change port mode to SPP8, ECP, or EPP ( we recommend ECP or EPP, however 
this depends on what the computer may or may not support ).

6. Save the changes and exit out of BIOS.

 3.5 PC USB Ports

USB ports provide a fast, easy, and reliable way to develop projects. Up to 4 separate Spectrum Digital USB 
JTAG emulators can be attached at any given time to a PC. To get the Spectrum Digital USB JTAG emulator 
working, download and install the correct driver and CCStudio combination from the Spectrum Digital support 
website. ( http://support.spectrumdigital.com/ ). Follow these steps to setup your USB JTAG emulator:

1. Connect the USB JTAG emulator to your PC through a USB cable. When first plugged in, the red USB-
ACTIVE light will light for about one second then turn off.

2. Windows will pop up its "Add New Hardware" wizard.

3. Select the "Install from a specific location" option.

4. Now select "Search for the best driver" option and use the browse function to include 
specdig/xds510usb subdirectory of your Code Composer installation.
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 3.6 Configuring Your Emulator

You can use SDConfig to configure your emulator with advanced options. Configuring the emulator is an 
important step before you can use utilize the emulator. Your PC may only be able to function on a specific port 
address and at a specific speed. On top of that some development board can only run at slower port speed 
than normal. Follow these steps to configure your emulator:

1. Launch SDConfig.

2. Click on the I/O port address number that corresponds to your emulator.

3. In the Emu folder, change the port mode and port speed.

4. Save the changes ( File -> Save ).

5. Retest your emulator ( Emulator -> Test ).

 3.7 OMAP RTCK Setup

Using a Spectrum Digital JTAG emulator with a TI OMAP16xx device requires additional setup through 
SDConfig. The OMAP16xx processors have a default RTCK generally in the low MHz range, while the typical 
RTCK runs at 12-MHz. In order to correct this, you will have to modify the emulator port speed settings, it has 
the effect of adding delay to the emulation access. Using a setting of 8 is sufficient to support a 2 MHz RTCK.

1. Launch SDConfig

2. Click on the I/O port address number that corresponds to your emulator.

3. In the Emu folder, change the port speed to "8".

4. Save the changes ( File -> Save ).
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5. Retest your emulator ( Emulator -> Test ).
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 4 CCStudio Configuration

 4.1 Overview

CCStudio's use as a programming tool and debugging tool comes only after you have configured CCStudio to 
account for your emulator and board. Configuration of CCStudio requires specific parameters in order to 
communicate with the emulator and board setup. Each emulator is communicated to differently and through a 
different I/O port. Each attached board has a unique JTAG scan chain built of individual processors.

 4.2 CCStudio Setup

Configuring CCStudio, to recognize your emulator and board, is the work of the "CCStudio Setup" tool. 
CCStudio Setup allows you to create the work environment for project development and project debugging. 
CCStudio Setup requires the specific information regarding the JTAG emulator and development board.

Here is a screen shot of CCStudio Setup v3.1 configured for a DSK6713 connected to an XDS510 USB JTAG 
emulator:

The information needed from the JTAG emulator includes:

• Emulator type - Whether the emulator is an XDS510 USB or XDS510 PP+.

• Emulator driver - The driver contains all the information and communication protocols for the emulator 
to talk to the individual processors on a board. The driver is specific to the DSP platform ( C6000, 
C5000, C2000, and OMAP ) and specific to the emulator type.

• I/O port address - Specify which I/O port is being.

The information needed from the board includes:

• JTAG scan chain - The logical setup of how the individual processors are arranged. This information 
also expresses the processor type and the order of each processor.

• GEL files - A GEL file is a collection of functions that perform various actions when using CCStudio. 
The GEL (General Extension Language) scripting language is the only way to extend CCStudio's 
capability.
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 4.3 CCStudio Setup Methods

The 2 main ways detailing the use of CCStudio Setup are automatic and manual. This guides briefly goes 
through both version, but HIGHLY recommends that you choose the automatic CCStudio Setup. Manual setup 
should be reserved only for special situations where you have built your own development board.

 4.4 CCStudio Auto Configuration

Automatic configuration is highly recommended for all Spectrum Digital target development boards. Pre-
configured CCStudio configuration files are included for each Spectrum Digital board. These configuration files 
provide all the need information to CCStudio for a quick and easy setup. These files can be downloaded from 
the Spectrum Digital website, along with the detailed instructions. The procedure for automatic configuration is 
CCStudio version dependent and is described here:

Automatic CCStudio v3.1x configuration instructions ( http://support.spectrumdigital.com/ccs31/ )

Automatic CCStudio v2.2x configuration instructions ( http://support.spectrumdigital.com/ccs221/ )

 4.5 CCStudio Manual Configuration

Manual configuration for any board will require more steps to be performed, which were already performed in 
the automatic configuration, to be done by the user. These steps include setting the emulator type, I/O port 
address, JTAG scan chain, and GEL files. This process is typically done when the user build their own boards 
and connect them with a Spectrum Digital Emulator. The procedure for manual configuration is CCStudio 
version dependent and is described here:

 4.5.1 CCStudio v3.1

Manual CCStudio v3.1x configuration instructions ( http://support.spectrumdigital.com/ccs31/manual/ )

This is a guide to installing the Spectrum Digital XDS510 USB JTAG emulator -or- XDS510 PP+ JTAG 
emulator for use with CCStudio v3.1. These instructions assume that you have already installed CCStudio in 
the default directory. ( c:\CCStudio_v3.1 ) If you have chosen to install CCStudio in a different location you 
must manually adjust each step below to match your actual install path.

To illustrate how to manually configure CCStudio v3.1, you will be guided on how to configure CCStudio 
for a Spectrum Digital XDS510 USB JTAG emulator connected to an EVM5509.

1. Launch the desktop icon [Setup CCStudio v3.1]

2. Press the Remove All button to clean up the System Configuration pane.

3. In the Create Board tab double click on the "SD510USB Emulator" option.
Available Connections Option Spectrum Digital JTAG emulator
SD510 Emulator XDS510 PP+ JTAG emulator
SD510USB Emulator XDS510 USB JTAG emulator
SDDSKUSB Emulator Embedded DSK JTAG emulator

4. In the new Connection Properties window enter a name for this setup, "USB Emulator", then press 
Next.
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5. Now select the Emulator I/O port, "USB Emulator address is 0x510", then press Finish.

6. Now choose, from Available Processors double click on "TMS320C5500".

7. Each individual processor needs a Processor Name, use the "TMS320C5500_0", then browse for 
the GEL File located at "c:\CCStudio_v3.1\boards\evm5509\gel\sd5509evm.gel", then press OK.

8. Save the settings ( File --> Save )

9. Exit out of CCStudio Setup and start CCStudio v3.1.

 4.5.2 CCStudio v2.21

Manual CCStudio v2.2x configuration instructions ( http://support.spectrumdigital.com/ccs221/manual/ )

This page is a guide to installing the Spectrum Digital XDS510 USB JTAG emulator -or- XDS510 PP+ JTAG 
emulator for use with CCStudio v2.21. These instructions assume that you have already installed CCStudio in 
the default directory. ( c:\ti ) If you have chosen to install CCStudio in a different location you must manually 
adjust each step below to match your actual install path.

To illustrate how to manually configure CCStudio v2.21, you will be guided on how to configure CCStudio 
for a Spectrum Digital XDS510 USB JTAG emulator connected to an EVM5509.

1. Launch the desktop icon [Setup CCS2 OMAP].

2. Press the Clear button to clean up the System Configuration pane.

3. Close the Import Configuration window.

4. Click on Install a Device Driver.

5. Browse for the driver, "sdgo55xxusb.dvr", at c:\ti\drivers\sdgo55xxusb.dvr, enter a Device Driver 
Name, "sdgo55xxusb", then press OK.

6. In the middle pane double click on newly created icon, "sdgo55xxusb".

7. In the new Board Properties window, enter a board name, "sdgo55xxusb", then press Next.

8. Now enter the I/O port, for the XDS510USB its "0x510", then press Next.

9. Now from Available Processors double click on "TMS320C5500", press Next.

10.For each individual processor, enter the GEL File location, 
"c:\ti\boards\evm5509\gel\sd5509evm.gel", then press Finish.

11.The newly created setup will appear in the left pane under My System and reflects what was just 
entered during the setup.

12.Save your settings ( File --> Save )
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13.Exit out of CCStudio Setup and start CCStudio v2.21.
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 5 CCStudio Application

 5.1 Overview

CCStudio offers an easy-to-use configuration and graphical tools to streamline system design and development 
time. CCStudio provides direct access to individual DSP processors on your target board, when used in 
conjunction with our Spectrum Digital JTAG emulators, to provide easy access to source code and debugging.

Here is a screen shot of CCStudio v3.1:

 5.2 CCStudio Versions

There are various versions of CCStudio in current circulation, each has difference between the other versions 
of CCStudio. These differences affect what processors are available to debug, how code is to be run, and how 
projects are compiled. Depending on your version of CCStudio there may be additional steps you will have to 
take to ensure your own projects will run correctly.

The latest version ( CCStudio v3.1 Platinum ) merges support for all DSP platforms (C6000, C5000, C2000, 
and OMAP) into one application. A much more detailed summary of all features can be found on the TI website: 
http://dspvillage.ti.com/ .

 5.2.1 CCStudio Version Differences

 5.2.1.1 DSP Platforms

The most obvious change in CCStudio, is that the latest version supports all the DSP platforms, while earlier 
versions of CCStudio were developed to support only one DSP platform. Here is a list of the previous CCStudio 
versions and what each supported.

CCStudio Version DSP Family Supports
v3.1 Platinum C6000 C5000 C2000 OMAP 
v3.0 for C6000 C6000    
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v3.0 for OMAP  C5000  OMAP 
v3.0 for C2000   C2000  
v2.21 for C6000 C6000    
v2.21 for OMAP  C5000  OMAP 
v2.21 for C2000   C2000  

 5.2.1.2 DSP/BIOS Versions

DSP/BIOS is a real-time operating system with features such as task scheduling and prioritization, inter-task 
communication and memory management. The version of DSP/BIOS may change with each release of 
CCStudio. When migrating a project built with an older version of CCStudio to a newer version of CCStudio, the 
DSP/BIOS CDB file must be updated. There are 2 ways to accomplish this, through a graphical interface or 
through Tconf, a command line based interface:

• Upgrading CDB Files with Tconf - Tconf scripts contain text based commands that modify the 
modules within a CDB file. By running a Tconf script, a new CDB file will be generated from the new 
CDB seed file in the latest version of CCStudio. The older CDB will be replaced with the newly 
generated CDB file. Tconf details can be found in the DSP/BIOS TexTconf User's Guide ( SPRU007 ).

• Upgrading CDB Files Manually - Start the newer version of CCStudio and open the project. In the 
project viewer double-click on the DSP/BIOS CDB file to open it. CCStudio will inform you that the 
DSP/BIOS is out of date and must be updated, press the OK to update button. When complete, the 
DSP/BIOS manager will appear, save the new DSP/BIOS window and rebuilt your project.

 5.2.1.3 Config Files

Under the Automatic Configuration option when configuring CCStudio, CCStudio v3.1 and v2.21 require the 
use of pre-configure config files. These config files are generated from the export option ( File -> Export ) found 
in CCStudio Setup. The exported config files under version 2.21 can be used in version 3.1, however the same 
is not true when using version 3.1 under version 2.21. The incompatibilities can be avoid by downloading the 
latest config files from the Spectrum Digital support website ( http://support.spectrumdigital.com/ ).

A second incompatibility arises when using heterogeneous driver or OMAP related config files. The 
heterogeneous driver, as it sounds like, allows for multiple independent processors to be arranged on a scan 
chain. CCStudio Setup v3.1 no longer needs the support of heterogeneous driver, used for most OMAP config 
files, because the behavior of CCStudio Setup was changed to automatically support multiple independent 
processors. This means that CCStudio Setup v3.1 can create any JTAG scan chain from the various DSP 
platforms without the help of this external heterogeneous driver. New OMAP drivers are located on the 
Spectrum Digital support website under the CCStudio v3.1 page( http://support.spectrumdigital.com/ccs31/ ).

 5.2.1.4 GEL Files

After CCStudio v2.xx, GEL files required an OnTargetConnect() call to support the Connect/Disconnect function 
in CCStudio 3.xx. On previous GEL files, before CCStudio v3.xx, the StartUp() function managed setting the 
Memory Map and Registers. The role of StartUp() has been lessened to only perform Memory Map functions, 
since CCStudio is not automatically connected to a target board on Startup. Splitting the startup sequence 
causes older GEL files to generate errors when used on the new versions of CCStudio. There are 2 ways to 
avoid these GEL problems:
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1. Download the latest version of the GEL files, for CCStudio v3.1 you can go to the Spectrum Digital 
support website. ( http://support.spectrumdigital.com/ccs31/ )

2. Modify the existing GEL file, for special GEL files that you created, add the OnTargetConnect() function 
and move any non Memory Map code from StartUp() to OnTargetConnect(). You can still use this GEL 
file for CCStudio v2.21 and before if you add the OnTargetConnect() call in StartUp().

 5.2.1.5 CSL

The CSL is a collection of functions, macros, and symbols used to configure and control on-chip peripherals. It 
is at the heart of every TI component used under CCStudio. Each version of CCStudio may come out with a 
newer version of the CSL. When migrating your project from older to newer versions of CCStudio, it is 
important to relink all the files and build options to the new CSL library. This will ensure the new project does 
not mix with the previous version of CCStudio.

 5.2.1.6 CCStudio Installation

After CCStudio v2.xx, the installation directory changed from c:\ti\ to c:\CCStudio\ and c:\CCStudio_v3.1\ . 
These small changes fundamentally impact any project that migrates from CCStudio v2.xx to CCStudio v3.xx. 
Any hard linked files in the c:\ti\ directory should be changed to the new directory in order for the project to build 
properly in the new version of CCStudio. The best thing to do in this event is to download the latest version of 
the CSL from the TI website.
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 5.3 CCStudio Updates

Depending on when you acquired your version of CCStudio, it is always a good idea to use the available 
Update Advisor for your copy of CCStudio. In order to download any updates, TI does require some 
registration.

To Update CCStudio, follow these steps: 

1. Launch CCStudio from the desktop icon.

2. Select Help -> Update Advisor -> Check for Updates.

3. In the web browser, log on to TI's website, (if you are not yet register, now is a good time)

4. Download the updates for your version of CCStudio.

 5.4 TI DSP Developers' Village

TI offers the latest updates of CCStudio and its components via its the TI DSP Developers' Village. The DSP 
Developers' Village is a useful website to find out the latest DSP Resources, development tools, and DSP 
datasheets.

TI DSP Developers' Village ( http://dspvillage.ti.com/ )
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 6 CCStudio Components

 6.1 Overview

CCStudio has a wide variety of components and addons. In this section only the CSL and DSP/BIOS will be 
talked about.

 6.2 Chip Support Library (CSL)

The CSL is a collection of functions, macros, and symbols used to configure and control on-chip peripherals. It 
is an application programming interface (API), divided into sub-categories based on each on-chip peripheral. It 
is a component of the DSP/BIOS, which does not require the use of other DSP/BIOS components to operate. 
The CSL is used to shorten development time and to provide portability between different DSP in the same 
platform.

More information is available in the CCStudio help file.

 6.2.1 Supported DSP Platforms

The CSL's API only covers the C5400, C5500, and C6000 DSP Platforms. Compatibility and portability of the 
source code is maintained between members of the same DSP platform, but may vary when migrating between 
inter-platform members.

 6.2.2 Support Peripherals

A full summary of the on-chip peripheral list can be found in the CCStudio help file or at the TI website. The 
actual peripherals of each individual DSP processors is a subset of the full DSP platform list.

 6.2.3 Download CSL

The CSL can be downloaded free of charge from the TI website, for by using the Update Advisor in CCStudio.
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 6.3 DSP/BIOS

 6.3.1 Overview

DSP/BIOS is a real-time operating system developed by TI with features such as task scheduling and 
prioritization, inter-task communication and memory management. The operating system is small and modular 
so that any modules that are used can be compiled and linked into your application rather than a full blown 
operating system that exists completely separately from your code. In many ways it is like a code library that 
happens to perform operating system type functions.

 6.3.2 DSP/BIOS Projects

While the term DSP/BIOS refers to the operating system itself, the process of creating and maintaining a 
DSP/BIOS project actually involves a wide variety of different Code Composer Studio components which can 
also be used independently without the operating system. For example, DSP/BIOS manages device 
configuration through a graphical configuration manager but the resulting device initialization is implemented 
through the CSL.

 6.3.3 DSP/BIOS Components

This section is a brief introduction into the components that make up a DSP/BIOS project. It is only intended as 
an introduction and an organized way to point to Code Composer documentation that covers each feature in 
much more details. It must be noted that DSP development has a learning curve and cannot be mastered in 
just a few hours. If you are new to DSP development plan to spend plenty of time reading through the Code 
Composer documentation and experimenting on your own.

DSP/BIOS projects adds a new type of file called a DSP/BIOS configuration file (*.cdb). The configuration file 
contains settings for each of the DSP/BIOS modules. You can access the configuration file through a graphical 
interface (called gconf) by double-clicking on the .cdb file in the DSP/BIOS Config section of the project view. 
As you can see, the configuration file contains everything you need to set up a good working environment for 
your code memory management and layout ( System -> MEM ), interrupt vector table ( Scheduling -> HWI ) 
and on-chip peripheral setup CSL. All DSP/BIOS programs use a configuration file.

 6.3.4 Managing CDB Files and Projects

By far, the easiest way to start your own projects is to copy one of the example project directories to a new 
place and rename all of the files to match your new application. It is HIGHLY recommended that you follow this 
route because the example .cdb files are already configured to take advantage of features on each 
development board.

If you choose to create your own CDB files there are two distinct paths, creating one from a seed file and 
creating one with Tconf.

• Creating CDB Files Manually:
All user CDB files start as a CDB seed file. It is a CDB file with only the most basic settings for your 
particular hardware platform configured. To create a CDB file, select ( File -> New -> DSP/BIOS 
Configuration ) and you will be prompted to select a seed file to start with. The tool will open the CDB 
configuration tool and you can save the file under any name you choose.

• Creating CDB files with Tconf:
TexTconf ( Tconf for short ) is a script-based language used to manage CDB files. Tconf scripts contain 
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text based commands that modify the modules within a CDB file. When you run a Tconf script, the CDB 
will be generated from a seed CDB and used as a foundation, the script commands are applied and the 
resulting CDB file is written in a form that can then be included in your project. Tconf details can be 
found in the DSP/BIOS TexTconf User's Guide ( SPRU007 ).

 6.3.5 Building Projects with DSP/BIOS

Use the ( Project -> Add Files to Project ) to include your CDB file in your project. If you do not see the CDB file 
in the file browser, make sure the "Files of type" selector is set to .cdb files. When you add a CDB file to a 
project, Code Composer is smart enough to include most of the auto-generated files automatically in your 
project when the .cdb file is compiled. The only two files you usually need to worry about are appnamecfg.cmd 
which also needs to be manually added to your project (Project -> Add Files) and appnamecfg.h which needs 
to be included in your C source files with a line like:

#include "appnamecfg.h"

If you look in your project view you will see many include files. Most of them are not auto-generated files that 
you have to manage, they are simply headers for library modules that get referenced along the way and never 
change.

When a .cdb file is compiled, a number of files are generated based on the settings it contains. The generated 
files are included with your project to perform DSP/BIOS initialization of each module shown in the graphical 
configuration tool. If you look closely at the files you'll see that they are simply human readable source files just 
like your own code. The auto-generated files are used to minimize the complexity users need to see when 
integrating so many modules with such different functions. Consistency checking between modules that might 
have conflicts is done in the graphical configuration tool while you are editing it.
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 7 Hardware, Software, & Troubleshooting Guides
More guides are available for any extra information on Hardware or Troubleshooting:

• Troubleshooting Guide - For problems involving your JTAG emulator, development board, TI CCStudio, 
and your CCStudio projects.

• Software Guide - This guide

• Hardware Guide - For general information about the JTAG emulator hardware, daughtercards, general 
tips for hardware developers, and general tips on hardware features.

These 3 guides can be found on the Spectrum Digital Support Website ( http://support.spectrumdigital.com/ )
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